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About this guide
Welcome to the ISBE Assessment Delivery System User Guide. This guide provides
overview information and step-by-step instructions to help you use the Assessment
Delivery System (ADS), ISBE Teach, ISBE Management, and ISBE Learn, to administer
online assessments.
You will interact with components: ISBE Teach and ISBE Management for administrators,
and ISBE Learn for students.
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ADS User Roles
There are two roles in ISBE Teach and one for ISBE Learn.
ISBE Teach
•
•

Organization Administrator
Test Administrator

ISBE Learn
•

Student

The goal of this guide is to provide necessary information and instructions for people in
the title role.
The Organization Administrator (Org Admin) is a staff member who is granted access
at either the district or the school level. Org Admins with district-level permissions have
access to the district as well as all schools within the district. Org Admins with schoolonly permissions cannot view district users, classes or students outside of their assigned
school.
The Org Admin maintains schools in the district, as well as user accounts and access at
the district or school levels or both. Org Admins manage user accounts, student records,
and classes, as well as work with student data and test assignments. Local policy will
determine if student and class management is coordinated at the district or school level.
As an Org Admin, it’s important for you to be familiar with the features of ADS used by
the staff members you interact with and support.
A Test Administrator is a school staff member who administers or proctors online test
delivery in the ADS. As a test administrator, you may need to be familiar with features of
the ADS that other staff members use, such as your school’s test coordinator.
There is another role for ADS: the student who takes tests in ISBE Learn. While
students are not officially set up as users, you should understand how they interact with
the system.
Actions are often performed by multiple user roles. To make it clearer whether a
particular role can perform an action, you will find a role bar like this at the top of each
procedure.
Org Admin

Test Admin

Student

When a role is highlighted (all the roles are highlighted above), that user can perform
the procedure described. If a procedure is not available to a user role, it will be dimmed
in the role bar as shown below.
Org Admin
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Test Admin

Student

Introduction to ADS
Overview
The Illinois School Board of Education (ISBE) uses the Assessment Delivery System
(ADS) to administer the Illinois Science Assessment (ISA).
This section introduces you to the components of ADS that administrators and educators
use to set up organizations, users, and students; review test assignments; and
administer tests; and review score reports for the diagnostic test version.
As a District or School Organization Administrator or Test Administrator, you will
primarily work with ISBE Teach, where you will set up and maintain the tests. Test
Administrators will also work with ISBE Learn which is used to deliver the ISBE ISA
online assessment to your students.

Components of the Assessment Delivery System
The Assessment Delivery System (ADS) consists of two unique parts that administrators
and educators use to develop, assign, and administer ISBE online assessments.
ISBE Teach

Administrators:
Manage districts, schools, classes,
students and users.

ISBE Learn

Students:
Take online tests.

ISBE Teach
The bulk of a school’s preparation work occurs in ISBE Teach.
For the Illinois Science Assessment, ISBE will set up the organizations (districts and
schools) across the state as well as the District Organization Administrator(s) and School
Organization Administrators (per ISBE Entity Profile System (EPS)). In turn, Organization
Administrators (Org Admins) at the district will create additional school-level
Organization Administrators and all Test Administrators (Test Admins); Org Admins will
also assign Test Admins to classes. Org Admins (district or school depending on district
policy) will set up classes and students by using the integrated ISBE ISA Import Wizard
(ISBE Management Tool) that is embedded in ISBE Teach and connects to the ISBE SIS.
Test assignments will be automatically assigned to students by the student grade level.

ISBE Learn
Test Administrators will work closely with ISBE Learn. Students will not know what ISBE
Learn is even though they use this platform to take the test. Each student will enter a
unique access code, found on the student’s test ticket, into a browser on a school device
that meets technical requirements.
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Logging into ISBE Teach
To use the features described in the next several sections, you must log into ISBE Teach.
If you do not have a user login, contact your Org Admin (usually your
Superintendent/Director or Principal).
Org Admin

Test Admin

Student

1. Click the link below or open
your browser and type or
copy and paste the ISBE
Teach URL into the address
bar:
https://teachisa.ileducates.org
The Log In page opens.

2. Enter your e-mail address
or username and
password.
3. Click Log in under the
password field.

4. The ISBE Teach Dashboard
opens. This serves as your
home page for ISBE Teach.
Note: This dashboard will vary
depending on the User Role
assigned to you. The parts of
the dashboard are explained in
the next section of the guide.

Navigating in ISBE Teach
The dashboard displays a gallery of tiles that link to all the information and actions
available to you in ISBE Teach. The links will vary, depending on the number of schools
assigned to you and your role in the system. A Test Administrator, for example, typically
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sees only the tiles and menus for Students and Assigned Tests. The Test Status
Overview is located on the Dashboard page below the tiles.

Parts of the ISBE Teach Dashboard
Org Admin Dashboard (District Permissions)

Org Admin Dashboard (School Permissions)

Test Administrator Dashboard
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Test Status Overview Dashboard

Tiles – on the center of the dashboard are tiles that link you to the orgs, users, and
students assigned to you.
• Schools (District Org Admin only) – view schools in your district.
• Users (Org Admin only) – view, add, or upload users (setting up and
maintaining user accounts).
• Students – view, add, or upload students (creating and maintaining student
profiles).
• Assigned Tests (School Org Admin and Test Admin) – view tests assigned
to your classes and students.
Navigation Dashboard Menu – Each tile type is associated with an item located on
the left side Dashboard navigation menu. These menus are available to you anywhere
in ISBE Teach.
Org Admins
•
•
•
•

Districts (State Org Admin only) – view districts.
Schools (District Org Admin only) – view schools.
Users – view, add, or upload users at districts or schools.
Students – view all students or by class for permitted schools; show assigned
tests; generate access code by student; add single student to a class.
• Tests – list of assigned tests by Class; Generate Access Codes by class; list of
student test assignments, shows test status, provides test support actions,
download student test status report.
• Help – provides help information for the Test and Test platform.
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Test Administrator
• Students – view students for assigned classes; show assigned tests; generate
access code by student.
• Tests –list of assigned tests by Class; Generate Access Codes by class; list of
student test assignments, shows test status, provides test support actions.
• Help – provides help information for the Test administration and Test platform.
Test Status Overview Dashboard – Located below the dashboard tiles, this section
provides a summary of the student test status within your organizations. This is visible
to both Org Admins and Test Admins. Test Admins must be assigned to classes to see
data.
•
•

•
•

Org Filters – used to change the data that is shown on the charts and table.
Depending on users' permissions, may select the district, school and classes to
be shown.
Donut Charts – show the Submitted Tests (progress of students completing all
three test sections) and the Test Section Progress (progress of individual test
sections). Hover over sections of the charts to view details. Click on the chart
sections to navigate to the test details page and table.
Summary Table – view summary of test status for child organizations. Use
hyperlinks or bar chart labels to click through to Details page.
Export – Export a .CSV file of Summary table or Details table.

Parts of an ISBE Teach Information Page
ISBE Teach data is generally displayed in a list format, as shown below.

Page Name

Organization Name

Page Buttons
Org Filters

Page Name – Displays the name of the page.
Organization Name – Displays the name of the highest organization (State, District,
School) to which a user is assigned. If you belong to multiple orgs of that same level,
this field will show a drop-down filter.
Org Filters – Use the drop-down filters to select the District, School, Class information
displayed in the table. The filters shown will vary based on your organization permission
level.
Page Buttons – Select buttons to initiate the described action.
9

Operations – Select from the buttons on each row to take action on a specific user,
student or assignment.
Search List – Enter a term in the field to display only items containing your term.
Sortable Columns – Click the header of a list column to sort.
Page Navigation – Click a number to move through multiple pages of information.

Sorting and filtering lists in ISBE Teach
You can more quickly locate an item in a very long list by using the sort or filter
functions.
To filter lists, enter your search term in the Search field that appears above ADS lists.
Entries that do not include your terms will be hidden. For example, filtering a list of
students for “10” will return all students in Grade 10 plus any that have “10” in any
other field.
Click on the table header of the column to sort entries in a list. Click again to toggle
between ascending and descending order.

Getting help
ISA program support is provided through the various online resources and through the
ISBE Student Assessment and Accountability Division and our support partners.
•

For additional information about ISA, visit the ISBE Science page at
https://www.isbe.net/Pages/Illinois-Science-Assessment.aspx

•

Support telephone number: (855) 340-3911

•

Support email: isbe-isa-support@psionline.com (consider using the web form in
lieu of email)

•

Support chat: https://techsupportchat.psiexams.com/techsupportchat/isbechat.jsp

Online Help
Use the Help icon in the left navigation menu to search for information on ISA test
administration, ISBE Teach and ISBE Learn.

Test accommodations
All students can use the online test accessibility features: Text to Speech, Line Reader,
and Calculator.
Offline materials are available for students with testing accommodations that require
paper tests, a human reader, or Spanish transadaptations. Currently, Districts may
request secure testing materials via the Secure Document portal. Information about this
may be found in the help section on Teach. Updates to this process will be shared with
Districts as they arise. Note: Schools and Districts are responsible for scribing
student test responses made on paper tests into the corresponding online test
assignment. There is no offline scoring of paper tests.
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ISA Preparation Checklist
The following checklist provides a summary of the high-level steps that need to be
completed prior to the start of the test window.

Test Operation Set up
Completed by ISBE Assessment Team




Load Organizations (uses state RCDTS code)
Roster Students into default classes (5-default, 8-default, 11-default) (using ISBE
Management Tool)
Load initial set of District Organization Administrators (Org Admins) based on data
in ISBE’s Entity Profile System (EPS)

Completed by Districts/Schools Org Admins





Load Additional District and School Org Admins
Review Student Roster and Classes; Move students to new classes (optional)
Load Test Administrators (Test Admins)
Assign Test Administrators to Classes

Test Preparation & Management
Completed by Districts/Schools Org Admins
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Install Secure Exam Browser (SEB) on testing devices
Guide students through ISA Tutorial (optional)
Review Student Test Assignments (Org Admins/Test Admins)
Generate/Print Test Access Codes for Classes/Students (Org Admins/Test Admins)
Manage Student Test (Org Admin / Test Admin)
Download Student Test Status Report (Org Admin)

Working with users
User types
ISBE Teach administration-level users (district, school and test) must have accounts to
access ADS features. Most user accounts provide access to ISBE Teach for the purpose of
working with organization records, student data, and test assignments.
Those who administer or work with tests must also have user accounts, so that they can
access the student test assignments, testing status and other records in ISBE Teach.
Students do not have assigned user accounts for ISBE Learn. They get access codes for
each of their test sections specified for their organization level, as discussed in Taking
Tests.

User Roles
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Setting up and maintaining user accounts
Each staff member in the districts and schools who will work with ISBE Teach must have
a user account. Users may be added in bulk with the User Upload Template or individually
using the Add User feature. Use the User Upload Template to enter the information into a
comma-separated (.csv) file, and then upload the file through ISBE Teach. ISBE will prepopulate your district Organization Administrators who are listed as ISA administrators
and test coordinators in EPS. It will then be the responsibility of the Org Admins to create
accounts for additional District or School Org Admins and all Test Administrators.
Note: Users may be added individually using the Add User feature or in bulk with the User Upload
Template.

Adding Individual Users
Using the Add User Feature
Org Admin

Test Admin

1. Access the Add Single User
feature through two different
paths:
•

Click the
button on the
Users Dashboard menu bar
in ISBE Teach to access the
Upload Users Page.

•

Select the Add Single
User Button at the top of
the page.
The Add User page will
open.

2. Click on Users in the left
navigation to open the Users
summary page. Select the
Add Single User Button at
the top of the page.
The Add User page will
open.
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Student

3. Enter or select the following
information to create a new
user:
a) Email address
b) First name
c) Last name
d) Organization
e) User Role
Select Save to create the
user and return to the Users
summary page.
4. The new user is visible on the
Users Summary Page and will
be emailed a welcome
message with further
instructions.

5. To add multiple new users,
select the Save and add
another button once you
have entered the first new
user’s information. The new
user will be emailed a
welcome message and the
screen will refresh to an
empty Add user form.
Notes:
•

•
•
•
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The organization selection on the Add User page defaults to the primary organization to which
you have permission. If you have district permissions and a school was selected prior to
accessing the Add User page, the selected school will be shown in the Organization drop down
fields for the new user.
The Add User feature assigns users to a single organization. If new users should be associated
with multiple organizations, edit their user accounts to associate additional organizations after
their initial creation.
New users will receive email messages confirming their new accounts and containing timesensitive password creation URL prompt (this email is valid for 72 hours). These emails contain
the URL for ISBE Teach.
Creating Test Administrators: After uploading new test administrators, you should assign
them to classes so they can see students and rostered classes. See Assigning users to classes
for details. Org Admins do not have to be assigned to classes as they have access to all classes
at their permitted schools.

Uploading Users in Bulk
Preparing the user template for uploading
To download and prepare the user template for upload
Org Admin

Test Admin

Student

1. Open the Upload Users page.
Click the
button on the
Users tile in ISBE Teach or
click the Upload Users button
at the top of the Users Page.
The Upload Users page opens.
2. Click the link Tap User
Template to download the
template file. You will use the
template to set up the schools
or other organizations.

3. Open the file
tapuser_template.xlsx in MSExcel or another spreadsheet
software program.
Note: Make sure to keep the column headers as is in row 1, but delete the examples in rows 2-4 of the
User Upload Template..
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4. Enter each user’s information on a separate row:
• First name and Last name - the full name of the staff member to add as an ADS
user.
• Email - the person’s business email address.
• Roles - indicates the staff member’s functional role. May be organization
administrator or test administrator (All lowercase, no CAPS)
• State Code - two-letter postal code for the user’s state. (use IL)
• Organization Identifiers – Use the RCDTS code for the organization. To assign
more than one org to a user, separate RCDTS codes utilizing a comma in the
appropriate cell on the spreadsheet.
Note:
•

Assigning a user to a district will automatically grant that user permission to see all schools
within the selected district.

User Upload Template Tips
•

Keep the column headers in the User Upload Template. You should delete the
sample data before uploading your users.

•

The Roles field can be either: organization administrator or test administrator (All
lowercase, no CAPS)

•

The State Code should be: IL

•

The Organization Identifier is the full 15-digit RCDTS code for the LEA or school
level organization.
o

•

If you copy/paste information into the form, make sure to remove any extra spaces
after the information in the field.

•

Save your completed template as a CSV file prior to uploading it.
o
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Ensure that the leading zeros of the RCDTS are captured in the sheet or the
upload will fail. Change the Cell format to Custom; highlight general, replace
that word (general) with 15 zeros, then save.

If you use a Mac, use the Windows Comma Separated (.csv) option to
save your file.

5. Save the file in Windows
Comma Separated values
format (.csv).
Note: A .csv file does not
support multiple tabs. Your
computer displays a message
asking how you want to save
the file.

•

If the data tab was the
active sheet when you
saved the file, click Save
Active Sheet or OK.

•

Follow the on-screen
prompts to save the file.

Uploading user information

Org Admin

Test Admin

1. Click the
button on
the Users Dashboard
menu bar in ISBE Teach
or click the Upload
Users button at the top
of the Users page to
open the Upload Users
page.
2. Add the .csv file with user
information in one of two
ways:
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•

Drag the .csv file with
user information into
the box.

•

Click Add files, locate
and select the .csv file
with user information,
and then click Open.

Student

3. You will briefly see a
“Processing…” message.
If the upload completes
with no errors, you will see
Create User Accounts
Confirmation.
If Teach encounters
problems with the upload,
a page appears that lists
the errors. Correct your
.csv file and try the upload
again.
4. When you have
successfully uploaded
users, the number of users
visible to you on the ISBE
Teach dashboard will
increase.

Notes:
Upon upload and creation, new users will receive email messages confirming their new accounts and
containing a time-sensitive password creation URL prompt (this email is valid for 72 hours). These
emails contain the URL for ISBE Teach.
Uploading Test Administrators: After uploading new test administrators, you must assign them to
classes in order for them to see students and rostered classes. See Assigning users to classes for
details. It is not required to assign Org Admins to classes as they have access to all classes at their
permitted schools.
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Editing user information
Edit your own user account
Users can edit their own email address or
create a new password by selecting the My
account link from the account icon in the
upper right corner of the page.
Note: The email address used in the ISBE
Teach must match the email address
associated with the ISBE SIS system to roster
or update classes.

Editing another user’s account
As an Org Admin, you can edit another user’s information if the user is either a peer or a
subordinate within your organization, i.e., if you have district level permissions, you may
edit other district or school users within your district. If you have school level permissions,
you may edit other school users within your school.
To edit another user’s account
Org Admin

Test Admin

Student

1. Select the Users tile from
the ISBE Teach Dashboard
or select Users from the
left Navigation Menu.

2. Use the Org Filters above
the table to select the
organization of the user you
wish to edit.
For District Org Admins:
To see all the users at the
district level, select the –
Select School- option.
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Note: if you belong to multiple districts or multiple
schools, use the Organization Name filter to select the
desired organization.

3. Click the edit link under the
Operations column for the
user you want to change.
Note: If you cannot find
your user, be sure you are
displaying the correct
district or school.
4. The user page for your user
opens with the Edit tab
selected.
Beneath the Edit tab are
two additional tabs:
Account – used to edit the
user’s information.
Organization - used to
edit the user’s
organizational assignments.

5. Click the Account button to
edit account information.
You can edit the following:
•
•
•
•
•

Email Address
Current password
User Status
User Role
User Full Name

Note: To prevent a user from
accessing ISBE Teach, update
their Status to Blocked. Once a
user is blocked, you will no longer
be able to see them in your user
list

Click Save to save your
changes.
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6. Click the Organization tab
to edit a user’s
organizational
information.
•

Use the drop-down
fields to define the
user’s state, district, and
school.

•

Select Add to save a
new organization to the
user’s profile.

•

Select Remove to
remove an assigned
school.

Click Save to save your
changes.

Assigning Test Admins to Classes
Test Administrators must be assigned to classes before they can view rostered students,
generate test access codes (test tickets) for students, or manage student tests.
To assign a user to a class
Org Admin

Test Admin

1. Select the Users tile
from the ISBE Teach
Dashboard or select
Users from the left
Navigation Menu.

2. Use the Org Filters
above the table to
select the organization
of the user you wish to
assign to a class.
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Student

For District Org Admins: To see all the users at the district level, select the -Select
School- option.
Note: If you belong to multiple districts or multiple schools, use the Organization Name filter to
select the desired organization.

3. You may view the
classes currently
assigned to a Test Admin
by selecting the View
Classes button under
the Operations column in
the User list table.

4. Select the user(s) you
want to assign to a class
by checking the box to
the left of their name(s)
in the Users list.

5. Click the Assign to
Class button under the
Org Filters.

6. A list of classes appears.
Click the box to the left
of each class name you
want to assign to the
user(s).
Click Next
If successful, a
confirmation message
appears.
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To Unassign/Remove a Test Admin from a class
Org Admin

Test Admin

Student

1. Select the Users tile from
the ISBE Teach Dashboard or
select Users from the left
Navigation Menu.

2. Use the Org Filters above
the table to select the
organization of the user you
wish to unassign from a
class.

For District Org Admins: To see
all the users at the district level,
select the -Select School- option.

Note: If you belong to multiple districts or multiple schools,
use the Organization Name filter to select the desired
organization.

3. Select the View Classes
button under the Operations
column in the User list.
Note: If the View Classes
button is not visible, it indicates
that Test Admin is not assigned
to any classes

4. Select the check boxes next
to classes you wish to
remove from the Test Admin.
5. Select Unassign Class to
complete the action or
Cancel to leave the class
assignments as is.

Note: Once removed/unassigned from a class, a Test Admin will no longer be able to view the
rostered students in that class or their associated test assignments.
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Working with students and classes
Students, tests, and classes
Just as schools are related to districts, students must be linked to classes before a
student can be assigned to take a test. So, just like users and schools, students and
classes must be created.
As a District or School Administrator, you will use the ISBE ISA Import Wizard to select
the students and classes for the Illinois Science Assessment.
Additional Tool Uses:
•
•
•

Break students into more nuanced test sections (not required – can keep students in default)
Change Student testing location
Complete an on-demand sync between ISBE Teach & SIS

Note: If you are unable to access the ISA Wizard, verify that the email address associated with
your ISBE Teach account matches your account in SIS.

ISBE ISA Import Wizard

To use the ISA Import Wizard
Org Admin
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Test Admin

Student

Log into ISBE Teach.
1. Select ISBE Management
button located below the
Dashboard tiles. The ISA
Import Wizard will open.

2. Verify your account
information.
3. Review/update test window
date range
a) Update for all schools,
enter the date range in
the top set of text
boxes. Click Update All
Schools.
b) Update an individual
school, enter the date
range next to the
school. Click Update.
4. Select View/Edit Student
Roster to see the current
student roster.
5. Select View History to see
activity related to prior batch
submissions.

6. Review and Edit Roster
a) The current roster is
displayed in the grid on
the main roster page.
b) To make changes, use
either the CSV Editor or
the Online Editor
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Editing Student Roster using the CSV Editor
1. To edit by CSV, click CSV
Editor from the Roster home
screen.

2. You can update student
rosters at either the district
or an individual school level.
Download the file from the
preferred level.
3. Once the file has
downloaded, open it in an
editing program such as
Excel and make the
necessary changes. Save the
updated file.

4. Select the Modified File
5. Click Choose File and
browse to the edited file to
add it to the wizard.
6. Click Upload Student File to
upload the file.
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7. Once complete you will see a
success message stating the
number of successfully
uploaded records.
8. From here, you can exit this
screen by selecting buttons
to View Batch History or
Keep Working.

Editing Student Roster using the Online Editor
1. To edit the roster online,
click Online Editor from
the Roster home screen.

2. A student grid will open.
3. Use the onscreen filters
and search tools to
identify the subset of
students and data you
wish to update.
Note: Filter the selection
before you update the
records. Filters may be
applied by name, DOB, grade
level, section name and test
location.

4. Click the column headers
to sort the table by that
column.
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5. Update Records: Once the
subset of data is
identified, enter the new
Section Name and Test
Location in those fields.
Select Update Rows to
apply the changes.

6. Once the data update is
complete, you will see the
following message:
7. Select Submit Changes
to send the updates to the
ADS Teach.
Note: If you do not select
submit changes, none of your
changes will be saved.

8. Once complete, you will
see a confirmation screen
of the successful batch
submission.
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9. View Batch History shows
the history and record
counts for previously
submitted batches.

10. Exit the ISBE Import
Wizard and return to
ISBE Teach by closing the
window.
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Creating and maintaining student profiles
Before you can assign and administer ISBE online assessments to students in your district,
a record for each student must exist in ISBE Teach. To upload students, use the ISBE ISA
Import Wizard described above. The ISA Import Wizard will search SIS for exits and
enrollments and automatically remove/add students from/to your roster if they have not
started testing. However, if a previous district has not exited a student, please contact
the district/school contact and work to complete the exit and new enrollment process in
SIS. If time does not allow for this process (testing has started in your district), then
school administrators can follow the manual process detailed in the next section to add
the student to ISBE Teach. As always, as time allows, complete the work to keep SIS
updated.

Editing student information
To edit student information
Note: At the completion of the test, ISBE will use the student data as it is entered in SIS to
compile the final ISA results. If you make updates in ISBE-Teach to a student’s record, these will
not be captured unless you also update the record in SIS.
Org Admin

1. Select the Students tile
from the ISBE Teach
dashboard or select
Students from the left
Navigation Menu.
The Students page will
open.

2. Use the Org Filters
above the table to select
the organization of the
student you wish to edit.
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Test Admin

Student

3. Select the State
Identifier of the Student
you want to edit. The
Student Profile page
opens.

4. Click Edit Student to
make the profile editable.
5. Make the changes in the
student’s profile.
Note: fields marked with
an asterisk (*) are
required.
6. Click Save Student Data
at the bottom of the page.

Note on changing the State Student ID
Even though the State Student ID is editable, remember that it is a unique identifier of your
student.

Adding walk-in students
The ISBE ISA Import Wizard tool will search SIS for exits and enrollments and
automatically remove/add students from/to your roster if they have not started testing.
However, if a previous district has not exited a student, please contact the district/school
contact and work to complete the exit and new enrollment process in SIS. If time does
not allow for this process (testing has started in your district) then school administrators
can follow the manual process detailed below to add the student to ISBE Teach. As
always, as time allows, complete the work to keep SIS updated.
Adding a walk-in student
Note: The new student will automatically be assigned a test based on their grade level.

Org Admin
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Test Admin

Student

1. Select the Students
tile from the ISBE
Teach dashboard or
select Students from
the left Navigation
Menu.
The Students page will
open.
2. Use the Org Filters
above the table to select
the organization to
which you plan to add a
walk-in student.
If you have permissions
to more than one school,
ensure you add students
to the correct school.

34

3. Select the +Add Single
Student button. The
Add Student Page will
open.
You will be required to
enter or select the
following information:
•
•
•
•
•
•
•

State Student ID
Class
Grade
First Name
Last Name
Gender
Date of Birth

Click Save Student
Data at the bottom of
the page.

4. If the save was
successful, ISBE Teach
displays a confirmation
message.

Notes:
The new student will automatically be assigned a test based on their grade level.
The State Identifier for students entered as walk-in students is appended with the Org ID
(RCDTS code) for tracking purposes.
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Test Management
Tests will automatically be assigned to students based on the student’s grade level. All
students will have access to the following test features: Text to Speech, Line Reader,
Bookmark, Review and a Calculator. Each student taking the 2022 ISA will have three
(3) test sections assigned to them which means that they will have three (3) unique test
access codes assigned to them.
The titles of these test assignments follow this format (where X is 5, 8 or 11):
•
•
•

2022 Illinois Science Assessment - Grade X - Section 1
2022 Illinois Science Assessment - Grade X - Section 2
2022 Illinois Science Assessment - Grade X - Section 3

Test Status Overview Dashboard
The feature provides users with a responsive, summary view of the student test status
in the organizations to which they have permission. This feature is available to both
Org Admins and Test Admins. Test Admins must be assigned to classes to see data.
Users may use this feature to view aggregate summaries and detail tables.
Additionally, .CSV files may be exported that show all of the student detail on a single
row.

Using the Test Status Overview Dashboard
Org Admin

1. From the Dashboard tab in
Teach, scroll down below
the Dashboard tiles to view
the Test Status Overview
2. Use the Org Filters to
select the student and tests
data is shown in the charts
and tables.
With district-level
permissions, you can drill
down to schools or classes.
With school-level
permissions, you will see
both school and class
information.
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Test Admin

Student

3. Donut Chart – Submitted
Test. This is an aggregate
view of all three student
test sections that are
completed and submitted
for each student.
Users can hover over
sections in the chart to see
the number and percentage
of tests in each section.
Click on a section of the
chart to open a new page
containing test and student
details for that section of
the chart.

4. Donut Chart – Test
Section Progress. This
is a summary view of all
three individual test
sections assigned to all of
the students in your
organization.
Users may hover over the
chart and click on labeled
sections for more detail.

5. Summary Table – This is
a summary table of the
child-level organizations of
the organizations shown in
the donut charts.
If the donut charts show a
district-level summary, this
table shows school-level
totals. If the donut charts
show a school-level
summary, this table shows
class-level totals.
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6. Summary Export – This is
a .CSV file download of the
child-level summary
information in the
Summary Table.
Click the Export button
above the Summary Table
to access this file.

The .CSV file contains the following fields:
Organization Name, Organization RCDTS, Students, Assigned Tests,
Submitted Tests, Assigned Test Sections, Test Status (Scheduled,
In progress, Paused, Submitted).

7. Test Details Page
The table on this page
provides the student test
detail for the selected chart
section. Access this page
by any of the following:
Click on a section of a
donut chart.
Click on a section of the
donut charts or the bar
chart in the summary table.

Once selected, the test status detail for that set of data
will open on a new page.

Click on a hyperlink in the
summary table.

8. Export Test Detail –
Download a .csv file of the
detail shown on the Test
Status Detail page by
clicking the Export button
above the table.

The .CSV file contains the following fields:
District Name, District RCDTS, School Name, School RCDTS, Class Name,
Section Number, Student ID, First Name, Last Name, Grade, Test Section 1,
Test Section 1 Status, Test Section 1 Access Code, Test Section 2,
Test Section 2 Status, Test Section 2 Access Code, Test Section 3,
Test Section 3 Status, Test Section 3 Access Code

Note: Organization Admins may use this feature to download a .csv file containing the test
details of all students in a school. District Org Admins - select the student hyperlink in the
summary table to open the Test Details page. Click the export button to download the .csv file.
School Org Admins – select the Export Schools button (next to the Export Classes button) to
open a Test Details page and access the export button.
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Reviewing test status

You will be able to see the test status for each student once a test is assigned to them.
In its initial state, the test status will be “Scheduled.” When a student has completed
testing, the test status will change to “Submitted.”
To review the test status for students in a class
Org Admin

Test Admin

Student

1. Select the Assigned
Tests tile from the
ISBE Teach dashboard
or select Tests from
the left Navigation
Menu.

2. Select the Tests
Assignments tab.
Use the Org Filters
above the table to
select the school and
class for the student
or class whose test
status you want to
know.
3. To search for a
specific phrase or
test section in the list
of tests, use quote
marks around the
section name (e.g.
“section 1”) in the
search field to allow
for a discreet search.
The standard codes for test status are:
• Scheduled – a test has been assigned and not yet begun
• In progress – a student has navigated to the first question of the test
• Paused – a student has exited the test, or the test has been unlocked for them
• Canceled – the test has been canceled
• Submitted – the test has been submitted.
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Cancel a test
If a student is no longer eligible or required to take the ISA, you may cancel their test.
To cancel a student’s test
Org Admin

Test Admin

1. Select the Assigned
Tests tile from the ISBE
Teach dashboard or
select Tests from the
left Navigation Menu.

2. Select the Tests
Assignments tab.
Use the Org Filters
above the table to select
the school and class for
the Student whose test
you want to cancel.

3. To search for a
specific test section in
the list of tests, use
quote marks around the
section name (e.g.,
“section 1”) in the
search field. You may
also search for specific
students by name or
student state ID.
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Student

4. Select the Cancel Test
button under the
Operations column in
the student’s row.
Follow the instructions on
the verification screen to
complete cancelling the
test.
5. The following banner will
be displayed when the
test is successfully
cancelled.

Restore a test
In the event that a student’s test was accidentally cancelled, you may restore their test
assignment.

Org Admin

Test Admin

1. Select the Assigned
Tests tile from the ISBE
Teach dashboard or
select Tests from the left
Navigation Menu.
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Student

2. Select the Tests
Assignments tab.
Use the Org Filters
above the table to select
the school and class for
the Student whose test
you want to restore.

3. To search for a specific
test section in the list of
tests, use quote marks
around the section name
(e.g., “section 1”) in
the search field. You
may also search for
specific students by
name.
4. Identify the row with
the specific test to
update and select the
Restore Test button
under the Operations
column.
Follow the instructions on
the verification screen to
complete restoring the
test.
5. The following banner will
be displayed when the
test is successfully
restored.

Reset a Student Login
If a student receives an error message indicating that their test has been locked, Org
Admins have permission to reset a Student Login. This unlocks a student’s test and
enables the student to resume the test from their most recent item.
Warning: Using this button while a student is actively taking a test will cause the
student’s test to display an error. You should only use the reset student login if the
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student receives a test-locked error message. Repeated clicking of this function could
cause multiple errors. Once an Org Admin has successfully completed the reset, the test
status of the student will change from In Progress to Paused.
To restore a student’s test
Org Admin

Test Admin

Student

1. Select the Assigned Tests
tile from the ISBE Teach
dashboard or select Tests
from the left Navigation Menu.

2. Select the Tests Assignments
tab.
Use the Org Filters above the
table to select the school and
class for the Student whose
test you want to reset.

3. To search for a specific test
section in the list of tests,
use quote marks around the
section name (e.g., “section
1”) in the search field. You
can also search for specific
students by name.

4. Identify the row with the
specific test to update, select
the Reset Student Login
button under the Operations
column in the student’s row.
Follow the instructions on the
verification screen to complete
restoring the test.
Once an Org Admin has successfully completed the reset, the student’s test status on
the Test Assignment page will change from In Progress to Paused.
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Student Test Status Reports
Organization Admins can download a report of student test status in their organization(s)
once tests have been assigned to students. This is a particularly helpful tool at the end
of the test to verify that all students have submitted their completed tests. Appendix B
provides instructions on creating an Excel PivotTable to summarize and analyze the data
in the Student Test Status Report.
To download the Student Test Status report.
Org Admin

Test Admin

Student

1. Select the Assigned
Tests tile from the ISBE
Teach dashboard or
select Tests from the left
Navigation Menu.

2. Select the Tests
Assignments tab.

If you have District
permissions, you will see
two links:

The following fields are included in the downloaded .CSV files
District Report

School Report

School name
School RCTDS
Class name
Test name
Test Grade
Last name
First name
Student ID
Access Code
Test Status

•

All district Student
report

District name

•

All School report (for
the selected school)

School name

If you have School
permissions, you will see a
single link for all the
students in the selected
school.

District RCTDS
School RCTDS
Class name
Test name
Test Grade
Last name
First name
Student ID
Access Code
Test Status
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Notes:
•

Once the download CSV link is clicked, the file download will be managed by the browser you
are using.

•

All students with assigned tests, regardless of their test status, will be shown in these
reports. Each student test assignment will be on a unique row. Each student taking the 2022
ISA will have three (3) test sections assigned to them which means that they will have three
(3) unique test access codes assigned to them.

•

The titles of these test assignments will follow this format (where X is 5, 8 or 11):

•
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o

2022 Illinois Science Assessment - Grade X - Section 1

o

2022 Illinois Science Assessment - Grade X - Section 2

o

2022 Illinois Science Assessment - Grade X - Section 3

Tip: This report can also be used to download all the access codes for your district or school
at one time. Appendix C shows how to organize the data into separate Test Sections.

Submit Tests in Paused or In Progress Status
Once all students in your district and or school have completed testing, tests left in
Paused or In Progress may be submitted by Org Admins using the Submit Test feature.
First, ensure the student in fact finished engaging with the test (even if not all items
were attempted), then use the Submit Test feature to place the student record(s) into
“Submitted” status for scoring.
Once a test is submitted, it is not possible for the student to continue working on that
section of the test.
To submit tests in Paused or In Progress status
Org Admin

Test Admin

Student

1. Select the Assigned
Tests tile from the ISBE
Teach dashboard or
select Tests from the left
Navigation Menu.

2. Select the Submit
Student Tests tab.
Only tests in Paused or
In Progress status will be
shown on the displayed
table.
Use the Org filters to
select the school and/or
class of the student(s)
test(s) to be submitted.
3. To search for a specific
test section in the list of
tests, use quote marks
around the section name
(e.g., “section 1”) in
the search field. You may
also search for students
by name.
Note: In Progress student tests will not appear on this page until their status has not changed for 3
hours.
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Submit a single test
1. Select the Submit Test
button in the operations
field of the student test
that is to be submitted.
Follow the instructions on
the verification screen to
complete the test
submission.

2. The following banner will
be displayed when the
test is successfully
submitted.
Note: The displayed status will not update immediately. Depending on system traffic, it could take up
to 5 minutes for the updated status to be shown in ISBE Teach.

Submit multiple tests
1. To submit multiple tests,
select the check box to the
left of the student test in
the table.
To submit all entries in the
table, select the check box
in the header row.

2. Once the tests to submit
are checked, select the
Submit selected tests
button.
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3. A confirmation message
listing the number of
selected tests and the
student name(s) will
appear. Follow the
onscreen prompts to
complete the bulk submit.
4. A success banner will be
shown when the test
assignments are
successfully submitted.
Note: The displayed status will not update immediately. Depending on system traffic, it could take up
to 5 minutes for the updated status to be shown in ISBE Teach.
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Taking Tests
Before taking the Illinois Science Assessment, a student must have an access code (a
unique code that provides one student with access to one specific test) for each test
section, and access to a school computer that meets the technical requirements of the
Assessment Delivery Platform. See the section “Printing Test Access Codes” section
below for details.
Access codes (test tickets) are generated for each student and assessment combination
after test assignments are made. Check with your school Org Administrator to find out
how these access codes are provided to the students. Depending on local policy, you
may be required to provide these codes to students at test time.
Tests will be administered using a Safe Exam Browser (SEB) which locks down the
device, preventing the student from navigating away from the test mid-assessment.
Ensure that the SEB is properly deployed and installed on all testing devices prior to
initiating student testing. SEB information for the ISA can be found on the ISBE
Website. Current versions are listed in Appendix D. The ISA SEB has a unique
configuration applied to it, and the ISA will only work with the official ISA SEB.
Students will be required to complete three (3) different test sections to complete the
entire ISA exam. The test sections will appear as three tests on the Assigned Tests
page, and students will need a unique access code to take each test section. To
maintain test security, only print and distribute the set of access codes for the current
test section to students at a time. Students within a class/session must start the section
together, work at their own paces to finish, then start the next section together if testing
more than one section in a session. Students cannot be issued all codes at once.
The titles of test assignments will follow this format (where X is 5, 8 or 11):
•
•
•

2022 Illinois Science Assessment - Grade X - Section 1
2022 Illinois Science Assessment - Grade X - Section 2
2022 Illinois Science Assessment - Grade X - Section 3

Printing Test Access Codes / Tickets
Before a student can take a test, you must generate an access code (test ticket), which
is a unique code that provides one student with access to one assessment. ISBE Teach
generates access codes for each student and assessment combination. Access codes may
be downloaded as .PDF or as .CSV files. Appendix C shows how to group the access
codes provided on the CSV download link found on the of Test Assignment page by test
sections.
IMPORTANT: If you download the access codes as .CSV files, this data is editable. It is your
responsibility to ensure data integrity. Be especially careful if sorting the data to ensure that
assigned access codes remain associated with the correct students.
To Generate a Test Access Code for a Class
Org Admin
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Test Admin

Student

1. Select the Assigned Tests tile
from the ISBE Teach dashboard
or select Tests from the left
Navigation Menu.

2. Select the Tests Overview tab.
Use the Org Filters above the
table to select the school and
class for which you want to
generate access codes.
Note: Test Administrators must be assigned to a class before they can generate access codes.

3. In the Test Name column, find
the Test Section to be tested.
Click Generate Access Codes in
the Operations column of that
Test Section.
Note: If your class contains
students in multiple grades, you
will see a row for each of grade
levels. Generate access codes
for each grade level.
4. The Print access codes for a class
page shows the class and test
battery information for the codes.

• If the information is not correct, close the page.
• If the information is correct: Select the Print button for a formatted PDF of the
access codes -Or – Select the Download CSV button to download this list as a .CSV
file.
• Follow the on-screen prompts to complete this step.
Note: Access codes generated via the Test Overview page will only show codes for student test
assignments that are in the following status: Scheduled, In Progress, Paused. Test assignments
that are in Cancelled or Submitted status will be excluded from these lists.
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To Generate a Test Access Code for an individual student
Org Admin

1. Select the Students tile
from the ISBE Teach
dashboard or select
Students from the left
Navigation Menu.

2. Use the Org Filters above
the table to select the
school and class for the
student for whom you want
to print the access code.
Use the search field as
needed to find the student
and test section assignment.

3. Click Generate Access
Codes in the Operations
column for the Test Section
assignment list.
Select the specific Test
Section by clicking on the
name.
4. The Print access codes page
shows the test battery
information for the student.
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•

If the information is not
correct, close the page.

•

If the information is
correct, click Print
access code and go to
the next step.

Test Admin

Student

Logging in to take the test
When a student is ready to take the assigned assessment, he or she accesses ISBE
Learn in a testing room under the direction of a Teacher, proctor, test monitor, or other
educator.
To log into a test
Org Admin

1. On the ISBE Learn start
page, click Start.

2. The Login page opens.
Enter your access code.
Click Submit.

3. Next, ISBE Learn displays
your name, school, and
grade to confirm your
identity. Click Yes to
proceed, or No to start
over.

4. The test verification screen
shows the name of the test
and the test section. If this
is the correct test, click
Yes. If the wrong test is
displayed, click No and
speak to the Testing
Administrator or proctor
about the issue.
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Test Admin

Student

5. ISBE Learn displays the
Start Test page with basic
information and test
instructions.
To start the test, click Start
Test.

Instructions text:
Welcome! Today you will be taking the Illinois Science Assessment. Read each passage and/or
question carefully and then choose the best answer(s) for each question. You may look back at
the passage as often as necessary. If you have questions, raise your hand and a test
administrator will help you. You may now begin by clicking on the “Start Test” button.

53

Test screen layout
On each ISBE Learn page you will find the following items:
A. Your name
B. Question number and total number of questions in the test or section
C. Test name, in case of multiple sections in the test, this will also indicate the
Section Name
D. Pause & Logout (see Pausing, logging out, and resuming a test)
E. Full Screen toggle
F. Buttons for accessibility features (see Using accessibility features).
G. Next and Back buttons
H. Bookmark & Item Review List
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Taking tests
Each assessment is composed of one section. A test section may include related material
or questions of the same type.

Navigating in ISBE Learn

Org Admin

Test Admin

1. Log into ISBE Learn, enter
your access code, and click
Start Test. (See Logging in to
take the test for detailed
instructions.)
The Section Start page
provides you with the test
section name, the number of
questions, and instructions.
2. The Instructions (continued)
page provides additional
information for students.
Click the Click Here to Go On
button to view the first
question.
3. Several types of questions may
appear on a test.
• To answer a multiple-choice
question, click the correct
answer.
• To answer a short answer
question, enter the response in
the field provided.
• To enlarge the test window to
full screen, click Full Screen.
• To reduce the window to its
original size, click Full Screen
again.
• To navigate between
questions, click Next (
Back (
).
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) or

Student

Pausing, logging out, and resuming a test

Org Admin

1. To save your work so you
can return to it later, click
Pause & Logout at the top
left of your page.
ISBE Learn will display a
message to let you either
confirm that you want to
save your work and exit or
go back to the test.
2. To resume a test, log in with
your original access code.
ISBE Learn will confirm your
name and test.
Click Resume Test to
return to the place you
exited the test.
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Test Admin

Student

Submitting a test and exiting ISBE Learn

Org Admin

1. When you reach the end of a test,
ISBE Learn displays an End of the
Session page. From this screen, to
review your answers, use the Item
Review feature to navigate and
return to questions. Select the
Review button to reopen the
Review Item list if needed. If you
are ready to submit your test,
select Go On to go to the final
screen in order to Submit your
test.
2. ISBE Learn displays a final end of
test screen. Select Go Back to
return to the prior slide and the
review Item list. Select Submit
Test and Exit to submit your test.
Note: Students MUST select SUBMIT
TEST AND EXIT in order to submit
tests for scoring and complete the ISA.

3. ISBE Learn displays a message
allowing you to confirm that you
are ready to submit your test. Click
Yes to submit your test, or No to
return to the test.
Note: You cannot return to review
items on the test once you select Yes.

4. A final screen appears confirming
that your test has been submitted.
Click Return to Log In to return
to the ISBE Learn home page.
From there, you can close the ISBE
Learn page in your browser.
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Test Admin

Student

Note: Students taking the ISA on a Windows
machine might see the following screen after
clicking Return to Log In. This is ok and does
not impact your test. Click Resend to return to
the ISBE Learn home page.

Using accessibility features
Accessibility features are tools available to all students that assist with test questions.
Examples of accessibility features currently available in ISBE Learn are:

•
•
•
•
•

Text to Speech - which reads the question text and answer choices out loud to the
student
Line Reader - which students can use to focus on one line at a time
Calculator - which gives students access to a four-function calculator
Answer Eliminator - which allows students to cross off answers they don’t want
to select
Highlighter – which gives students the ability to highlight item text

When a feature is in use, a dark blue bar appears at the bottom of the tool button. Click
on the feature button to activate and deactivate its functionality.
To use the Line Reader
Org Admin

1. Click the Line Reader icon at
the bottom of the page. A
gray shadow appears over
the page, with a line
highlighted to help you focus
on your reading.
The highlight will move as
you scroll up or down the
page.
To stop using the Line
Reader, click the Line
Reader icon again.
Note: For iPad users, tap to
move the line.
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Test Admin

Student

To use Text-to-Speech
Org Admin

Test Admin

Student

Note: If you intend to use the Text to Speech feature, ensure that the volume on your testing device
is turned on/up prior to launching the SEB.

1. To listen to a voice read the
text on the page, click the
Text to Speech button.
There are four control
buttons: Click to Speak, Play,
Stop, and Settings.

2.

Click the Play icon to start
reading the lines on the
screen at the beginning of the
question. The line being read
is highlighted in yellow, and
the blue highlight moves from
word to word as they are
read.
Click Pause to stop the
reading. Click Play to begin
again where you left off.
Click Stop to stop reading
and return to the beginning
of the text block.

3. Click the Click to Speak icon
to enable the ability to click
on a sentence in the body of
the question to begin the text
to speech read back from
that point.
Note: To re-read the answer
choices, click on the sentence
prior to the lettered list of
answer choices.

59

4. Click the Settings icon, to
change the speed at which
the text is read or the voice
that reads text.
•

Set the speed to slow,
medium, or fast.

•

Listen to a female voice
(called Eva) or a male voice
(called Tom).

•

The playback default is set to
Eva at medium speed.

5. To exit Text to Speech, click
the TTS icon at the bottom of
the page.

To use the Calculator
Org Admin

Test Admin

Student

Note: The Calculator is available to all students at point during the test.
1. To activate the calculator,
click the calculator icon at the
bottom of the page.

2. Once open, the calculator can
be dragged to different spots
on the page. Use your mouse
to select the buttons and
functions on the calculator.
To deactivate the calculator,
click the calculator icon at the
bottom of the page.
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To use the Answer Eliminator
Org Admin

Test Admin

Student

Note: The Answer Eliminator can only be used on Multiple Choice questions.
1.

To activate the answer
eliminator tool, click the
icon at the bottom of the
page.

2.

Once activated, the possible
answer choices for multiple
choice questions will show a
button with an “X” at the
right.

3.

Students can visually cross
off one or more choices by
clicking on the button on
the right.
The cross off can be erased
by clicking on the button
again.

4. To deactivate the answer eliminator, click the button at the bottom of the page. Crossed

off items will persist within a test even if the tool is deactivated and activated again.

To use the Highlighter
Org Admin

1. To activate the highlighter,
click the icon at the bottom
of the page.

2. Once activated the onscreen pointer will show a
highlighter with the selected
color.
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Test Admin

Student

3. Change the highlighter pen
color by using the pen color
selector.

4. To highlight, click and drag
your mouse over the text to
highlight (as if drawing with
a highlighter)
Change the highlight color
or remove the highlight by
hovering over the text and
then using the floating
menu pointed to that text.
5. To deactivate the highlighter, click the button at the bottom of the page. Highlights will

persist within a test even if the tool is deactivated and activated again.
6. Note: Students using the touch screen component of an iPad will need to tap+hold+drag
to highlight text.
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Item Review & Bookmark
At any time during the test, students may select the bookmark or open the item review list.

To use the Bookmark & Item Review
Org Admin

1. The Bookmark and Review list are
accessible from the upper right
corner of the test driver.
If you wish to bookmark an item for
later reference, simply click the
bookmark icon in the header. To
remove a bookmark, click the
bookmark icon again.
2. Select the Review icon to see a list
of all the questions in the test
session.
Questions seen by students are
indicated by blue hyperlinks.
Students can use this list to review
which questions have been
answered or bookmarked and can
easily jump back to different
questions by selecting the question
number.
Close this list by clicking anywhere
on the question screen or by
clicking the “x” on the review list
box.
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Test Admin

Student

3. At the completion of the test
section, the Item Review list will
appear on the final screen.
Students may use this tool to verify
that answers were selected for all
questions and can jump back to
questions by selecting the question
number.

64

Administering Tests
Org Admin

Test Admin

Student

Before the test
Before the testing session, you should verify several items:
•

The computers are ready (i.e., that the SEB has been installed).
Current SEB versions are listed in Appendix C.

•
•

The students have been assigned to the correct class and tests.
All the access codes have been generated and prepared to present to students.

During the test
Students log into ISBE Learn using the access codes you provide. There is nothing you
need to do to start the test for them.

Handling unexpected conditions
Here are some basic things to do when unexpected conditions interrupt testing.
• Students’ access codes are incorrect. Log into Teach to verify the correct student
access codes.
• Student is unable to complete the test. The student should save and exit the test,
then log back into ISBE Learn with the same access code to resume testing where the
individual left off.
• Power outage, technology failure, or computer crash. ISBE Learn locks tests
when these conditions occur. Once power is restored an Org Admin must complete
the following steps:
1.
2.
3.
4.

Log into ISBE Teach.
Select Tests.
Click the Test Assignments tab.
Click the Reset Student Login link for the interrupted test assignments to
make the tests available again.
The student can then log back into ISBE Learn with the same access code and
resume testing.

• Any other issues. If a student receives an error code while testing, please use the
table below to troubleshoot the issue and attempt to resolve it yourself. If you are
unable to resolve the issue on your own, you may need to call ISBE Customer
Support (855) 340-3911. If the issue involves the ISBE Teach or ISBE Learn
software, be sure to write down any error codes that appear (they will be in the
format ADP-xxxx) as these codes will help Customer Support identify and resolve
your issues.
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Below is a list of more commonly encountered codes, what they might mean, and
the possible actions to take.

Error
Code

Error Description

Recommended Action

None

There was a problem
logging in because the
server cannot be
reached.

This error message appears if ISBE Learn cannot
communicate with the server while a student is
trying to log in.

There was a problem
starting your test.

This error message appears if ISBE Learn is
unable to communicate with the server or if
content is unable to be downloaded.

TD-1000

Check that the student computer has internet
connectivity and that the Secure Exam Browser is
up to date.

First, check the network internet connectivity the
student’ computer. If possible, attempt to save &
exit the test, and then log in again.
If the error persists, contact the ISBE ISA
support desk.
ADP-1206

The Access Code does
not match our records.

This error message appears when the access
code used by the student doesn’t exist in the
system.
Verify the student’s access code in ISBE Teach
and try again.

ADP-1210

The test you are trying
to take requires the use
of the Secure Browser.

This error message appears if the student
attempts to enter the access code using a nonsecure browser rather than the SEB.
Check that the student computer has an SEB
installed.

ADP-1228

Test is already in
progress.

This error message appears when the student
attempts to open another tab using the same
browser/different browser.
Verify the student’s access code in ISBE Teach
and try again. If a student receives an error
message that their test is locked, follow the steps
to Reset a Student Login

66

Error
Code

Error Description

Recommended Action

ADP-1229

There was a problem
logging in because our
records show that you
are already logged in
and your test is locked.

This error usually happens if a student had a
power outage, technology failure, or computer
crash in the middle of their previous test session.

Your test has been
submitted or Canceled.
Please ask the teacher
for help before moving
on.

When the student submitted a test and tried to
log back into the test driver, they will see this
error message.

ADP-1230

Once power or the computer is restored to
normal, an Org Admin can Reset Student Login
to allow the student to log back in and resume
testing.

When the student’s test is canceled by the
teacher and they try to log back in /navigate to
the next item when taking the test, they will see
this error message.
An Org Admin can Restore the test from the
Tests/Test Assignment page, so the student can
Resume their test.

ADP-1231

Test is already in
progress.

This error message appears if a second instance
of a test that is already In Progress is started.
Once you’ve confirmed that the student is taking
the correct test, an Org Admin should find that
student’s test on the Tests/Test Assignment
page, and then select the Reset Student Login
button (following the on-screen prompts to
complete the action). When complete, you
should notice that the test status changed from
In Progress to Paused.

ADP-1232
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Test is not yet In
Progress, but there is a
valid Test Session
Token which hasn't
expired yet.

Session token hasn’t expired yet.
Once you’ve confirmed that the student is taking
the correct test, an Org Admin should find that
student’s test on the Tests/Test Assignment
page, and then select the Reset Student Login
button (following the on-screen prompts to
complete the action). When complete, you
should notice that the test status changed from
In Progress to Paused.

Error
Code

Error Description

Recommended Action
This error is thrown when a student’s test is
trying to download content but doesn’t have a
valid token. This usually happens if their token
expired (e.g., the student waited too long on
confirmation pages) or someone reset their test
(their token) while they were mid-test.

ADP-1300

If a student was in a test or in the process of
logging on when their test was reset, this will
cause this error. If the student logs back in and
receives a 1232 error, an Org Admin should
complete the Reset test process (which will
change it from In Progress to Paused status).
The student will then be able to resume their
test.
ADP-1451

There was a problem
saving your test results.

Quit Secure Exam Browser and log back in using
the same Access Code to resume the test.

Or

When the test is resumed, item responses are
restored using the last successfully saved test
results available on the server. If applicable,
make another attempt to submit the test.

There was a problem
submitting your test
results.
Escalate to Support
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ADP-1400

Test is a Practice Test

Escalate to Support

ADP-1401

Test Token doesn’t
match.

Escalate to Support

ADP-1402

Test Form Revision
Doesn’t match

Escalate to Support

ADP-1403

Test is already
Submitted and cannot
be resumed.

Escalate to Support

ADP-1404

Test is already
Completed and cannot
be resumed.

Escalate to Support

ADP-1405

Test is Canceled and
cannot be resumed.

Escalate to Support

ADP-1406

Test Token has Expired.

Escalate to Support

ADP-1407

No Test Results were
found.

Escalate to Support

Error
Code

Error Description

Recommended Action

ADP-1453

Test is already
Submitted and cannot
be taken.

Escalate to Support

ADP-1454

Test is already
Completed and cannot
be taken.

Escalate to Support

ADP-1455

Test is already
Canceled and cannot be
taken.

Escalate to Support

ADP-1456
to ADP16XX

Escalate to Support

After the test
After students submit their tests, ISBE Learn will automatically update the status of the
tests and submit the responses. In order for Students’ tests to be included in the final
ISA reporting, the tests must be in Submitted status. Organization Admins should
download the Student Test Status Report found on the Test Assignments page in
Teach to verify the test submission status of their students. They may also use the Test
Status Overview Dashboard to review student test status.
•
•

If a student completed the Pause & Logout function of a test instead of completing
the Submit functionality, their test status will show as Paused in Teach.
If a student exits the SEB without exiting the test, their test status will appear in
Teach as In Progress.

Once all students in your district and or school have completed testing, tests left in
Paused or In Progress may be submitted using the Submit Test feature. First, ensure
the student in fact finished engaging with the test (even if not all items were attempted),
then use the Submit Test feature to place the student record(s) into “Submitted” status
for scoring.
There is nothing you need to do to close out a testing session within Teach. Finally,
collect the student access code (test ticket) and assure destruction of it within the
district.
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Exiting the Safe Exam Browser (SEB)
Prior to exiting the SEB, make sure that your students have completed the process to
Submit their test. It is recommended that you properly exit the SEB at the end of the
testing session.
•
•
•
•
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For Windows – select the close button or use Ctrl + Q and use the exit code:
472317
For Macs – select the close button or use Command + Q and use the exit code:
472317
For Chromebooks – long press on the power button to turn off the machine.
For iPads – Select the red button in the top-right corner of the screen; use the
exit code: 472317.

Appendices
1. Appendix A: Form to Report a Testing Irregularity or Security Breach
2. Appendix B: Create an Excel Pivot Table to Summarize Student Test Status
3. Appendix C: Pull test access codes for a single test section using the CSV
download file.
4. Appendix D: Current SEB Versions
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Appendix A: Form to Report a Testing Irregularity or
Security Breach
2022 ISA
Instructions for the School Test Coordinator (STC) or LEA Test Coordinator (LTC):
1. Call your LTC to report a testing irregularity or security breach IMMEDIATELY upon discovering it.
2. Complete this form, if instructed to do so by ISBE or your LTC, fax it to ISBE at 217-782-6097.
3. Submit this form within two school days.
4. Maintain a copy of the submitted form for your school files.
Note: If the incident aﬀects more than a single student, attach a sheet with a list of all student names and SSID numbers.
Separate forms do NOT need to be completed for each student.
LEA/District Name:
LEA/District Organization Code:
School Name:
Role:

Contact Name:

❒ LTC

❒ STC

Contact Phone and Extension:

Date of Incident:
Mode: ❒ Computer

❒ Paper

Student Grade: ❒ 5

❒

8

❒ 11 Section #

❒1

❒2

❒3

❒ ALL

Test Administrator’s Name:
Student Name:

Date of Birth:

State Student ID Number:

Local Student ID:

Detailed Description of Incident

Investigation Steps Taken:

Actions Taken by Staﬀ to Resolve:

Was the incident resolved in a manner that allowed the student to continue testing? ❒ Yes ❒ No
If incident was related to a particular item, please provide item number (note that only students can read test content):
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Appendix B: Creating an Excel PivotTable
The following instructions will walk you through creating an Excel PivotTable. The Student Test
Status Report is downloaded as a .CSV file and includes all of the information needed to review
the test status of students in your school(s). PivotTables are a great way to quickly summarize,
analyze and explore data; using a PivotTable to review the student test status will quickly provide
a summarized report of student tests by school and status. PivotTables can also be used to
review test status at the class or even student level.
Before you get started:
•
•

To use a PivotTable, your data should be organized in a tabular format, and not have any
blank rows or columns.
Download the ISA Student Test Status Report and open the file in Excel.

Creating a PivotTable
1. Click a cell in the
spreadsheet.
2. Go to Insert > Tables >
PivotTable.
Note: If you're using Excel for
Mac 2011 and earlier, the
PivotTable button is on the
Data tab in the Analysis
group.
3. Excel will display the Create
PivotTable dialog with your
range or table name
selected.
4. In the Choose where you
want the PivotTable
report to be placed
section, select New
Worksheet.
5. Click OK.
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6. Excel will create a blank
PivotTable on a new
worksheet and display the
PivotTable Fields list on
the right side of the sheet.

7. Use the PivotTable Fields
form on the right to
manually drag-and-drop
items into the PivotTable
fields.
8. To create a summary
student report, move the
following items into the
PivotTable fields.
Rows:

School Name
Class Name

Columns: Test Status
Values:

Access Code

Note: If you are a District Org
Admin and you want to use
the PivotTable to analyze data
at a single school, drag-anddrop the School Name item
into the Filters area. Use the
filter selection in cell B1 above
the table to select the school
data you want displayed on
the PivotTable.
9. As you select items and
drop them into the
PivotTable fields, the data
will build the excel report
to the left.
10. If you no longer want an
item in your PivotTable,
simply drag it out of the
Fields list on the right or
uncheck it.
11. If you don’t see the Fields
list, click anywhere in the
PivotTable to open the list.
74

Appendix C: Pulling test access codes by a single test
section
The following instructions will walk you through using the Sort and Filter features of Excel to
organize the data in the Student Test Status Report to pull a set of test access codes by each of
the three test sections for a grade.
Before you get started:
•
•

To use sort and filter, your data should be organized in a tabular format, and not have any
blank rows or columns.
Download the CSV of test assignments with student access codes from the Test
Assignment page and open the file in Excel.

Sorting an Excel worksheet
1. Highlight the entire
worksheet to ensure that
the correct student
remains with the correct
test code.
2. Go to Data > Sort & Filter
> Sort.

3. In the Sort modal, select
Test name in the Sort by
drop down list and click
OK.

4. The Excel file will now be
sorted by test section. You
may copy/paste a single
section of tests for which
to distribute test access
codes.
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Filtering an Excel worksheet
1. Highlight the entire
worksheet to ensure that
all the information on the
spreadsheet is included in
the filter. A shortcut to
selecting the entire range
of spreadsheet data is to
click on the area between
Column A and Row 1
2. Go to Data > Sort & Filter
> Filter.

3. Once you click the Filter
feature, drop down arrows
will appear on the right
side of all column headers

4. Click the drop-down arrow
of the Test Name Column.
Use the check list to select
the specific test section.
Click OK.

5. The spreadsheet will now
only show the test
assignments for the
selected test.
To create a new worksheet
with only that test
information. Copy and
paste the filtered rows into
a new worksheet.
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Appendix D: Current ISA Safe Exam Browser (SEB)
Versions
Tests will be administered using a Safe Exam Browser (SEB) which locks down the device,
preventing the student from navigating away from the test mid-assessment. Ensure that the SEB
is properly deployed and installed on all testing devices prior to initiating student testing. The ISA
SEB has a unique configuration applied to it, and the ISA will only work with the official ISA SEB.
Additional SEB information for the ISA can be found on the ISBE Website.

The table below lists the versions of the SEB that will be used for this year’s ISA administration.
Links to the SEBs are available on the ISA page of the ISBE Website.
Operating System

SEB Version

Windows

Win 10

ISA SEB v3.3.1

Mac

macOS 10.15, 11, 12

ISA SEB v. 2.2.2

Chromebook

93-97

ISA 2022

iPad

iOS 13x -15.2

• The link to the current version is
available on the ISA page of the
ISBE website.

Supported Versions
• iPad Pro 9.7 inch +
• iPad Air (4th generation)
• iPad Air (3rd generation)
• iPad Air 2
• iPad Air
• iPad 5th generation
• iPad 6th generation
• iPad 7th generation
• iPad 8th generation
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Appendix E: Test Instructions
(Prior to launching the secure exam browser, adjust the volume level on the test device.)

Welcome Screen Text
Instructions
Welcome! Today you will be taking the Illinois Science Assessment for (Grade 5/8/11). Read each
passage and/or question carefully and then choose the best answer(s) for each question. You may
look back at the passage as often as necessary. If you have questions, raise your hand and a test
administrator will help you. You may now begin by clicking on the “Start Test” button.

Instructions Page Text
Instructions (continued)
At any time, you may select the “Bookmark” icon in the upper right corner to mark a question
you wish to come back to at a later time.
You may also select the “Review” icon to see a list of all of the questions that you have seen up to
that point. You can use this list to review which questions have been answered and to easily jump
back to different question by selecting the question number.
There are five tools you can use during the test: Text to Speech, Line Reader, Calculator, Answer
Eliminator, and Highlighter. To use a tool, select its icon located at the bottom of the page. Select
it again to turn it off.
You may need to use the scroll bar to view the entire question and all of the answer choices. For
constructed response questions, type your answer in the box provided. If you are unsure about
an answer, select or compose an answer that you think is the best response.
When you are finished with the question, select the next arrow (>) located at the right of each
page to go onto the next question. If you need to go back to a previous question, you may select
the back arrow (<) located on the left of the page or use the Review icon.

Select the GO ON button.
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